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This section of the User’s Guide provides instruction on using the CO2 from Fossil Fuel 
Combustion (CO2FFC) module of the State Inventory Tool (SIT), and describes the 
methodology used for estimating greenhouse gas emissions from fossil fuel combustion at 
the state level.  
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1.1 GETTING STARTED 

The Carbon Dioxide from Fossil Fuel Combustion (CO2FFC) module was developed using 
Microsoft® Excel 2000.  While the module will operate with older versions of Excel, it 
functions best with Excel 2000 or later.  If you are using Excel 2007 or later, instructions for 
opening the module will vary as outlined in the Excel basics below. Before you use the 
CO2FFC module, make sure your computer meets the system requirements.  In order to 
install and run the CO2FFC module, you must have: 

• IBM-PC compatible computer with the Windows 95 operating system or later; 

• Microsoft® Excel 1997 or later, with calculation set to automatic and macros 
enabled; 

• Hard drive with at least 20MB free; and 

• Monitor display setting of 800 x 600 or greater. 

Microsoft Excel Settings 

Excel 2003 and Earlier: For the SIT modules to function properly, Excel must be set to 
automatic calculation.  To check this setting, launch Microsoft Excel before opening the 
CO2FFC module.  Go to the Tools menu and select “Options...” Click on the “Calculations” 
tab and make sure that the radio button next to “Automatic” is selected, and then click on 
“OK” to close the window.  The security settings (discussed next) can also be adjusted at 
this time. 

Excel 2007 and Later: For the SIT modules to function properly, Excel must be set to 
automatic calculation.  Go to the Formulas ribbon and select “Calculation Options.” Make 
sure that the box next to the “Automatic” option is checked from the pop-up menu.   

Microsoft Excel Security 

Excel 2003 and Earlier: Because the SIT employs macros, you must have Excel security 
set to medium (recommended) or low (not recommended).  To change this setting, launch 
Microsoft Excel before opening the CO2FFC module.  Once in Excel, go to the Tools menu, 
click on the Macro sub-menu, and then select “Security” (see Figure 1).  The Security pop-
up box will appear.  Click on the “Security Level” tab and select medium.  When set to high, 
macros are automatically disabled; when set to medium, Excel will give you the choice to 
enable macros; when set to low, macros are always enabled. 

When Excel security is set to medium, users are asked upon opening the module whether to 
enable macros.  Macros must be enabled in order for the CO2FFC module to work.  Once 
they are enabled, the module will open to the control worksheet.  A message box will 
appear welcoming the user to the module.  Clicking on the “x” in the upper-right-hand 
corner of the message box will close it. 

Excel 2007 and Later: If Excel’s security settings are set at the default level a Security 
Warning appears above the formula box in Excel when the CO2FFC module is initially 
opened. The Security Warning lets the user know that some active content from the 
spreadsheet has been disabled, meaning that Excel has prevented the macros in the 
spreadsheet from functioning.  Because SIT needs macros in order to function properly, the 
user must click the “Options” button in the security message and then select, “Enable this 
content” in the pop-up box. Enabling the macro content for the SIT in this way only enables 
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macros temporarily in Excel but does not change the macro security settings.  Once macros 
are enabled, a message box will appear welcoming the user to module.  Click on the “x” in 
the upper right-hand corner to close the message box. 

If the Security Warning does not appear when the module is first opened, it may be 
necessary to change the security settings for macros.  To change the setting, first exit out 
of the CO2FFC module and re-launch Microsoft Excel before opening the CO2FFC module.  
Next, click on the Microsoft Excel icon in the top left of the screen. Scroll to the bottom of 
the menu and select the “Excel Options” button to the right of the main menu. When the 
Excel Options box appears, select “Trust Center” in left hand menu of the box.  Next, click 
the gray “Trust Center Settings” button.  When the Trust Center options box appears, click 
“Macro Settings” in the left hand menu and select “Disable all macros with notification.”  
Once the security level has been adjusted, open the Stationary Combustion module and 
enable macros in the manner described in the preceding paragraph. 

Viewing and Printing Data and Results 

The CO2FFC module contains some features to allow users to adjust the screen view and the 
appearance of the worksheets when they are printed.  Once a module has been opened, you 
can adjust the zoom by going to the Module Options Menu, and either typing in a zoom 
percentage or selecting one from the drop down menu.  In addition, data may not all appear 
on a single screen within each worksheet; if not, you may need to scroll up or down to view 
additional information. 

You may also adjust the print margins of the worksheets to ensure that desired portions of 
the CO2FFC module are printed.  To do so, go to the File menu, and then select “Print 
Preview.”  Click on “Page Break Preview” and drag the blue lines to the desired positions 
(see Figure 2).  To print this view, go to the File menu, and click “Print.”  To return to the 
normal view, go to the File menu, click “Print Preview,” and then click “Normal View.” 

Figure 1. Changing Security Settings 

 
 
 

Figure 2. Adjusting Print Margins 
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1.2  MODULE OVERVIEW 

This User’s Guide accompanies and explains the CO2FFC module of the SIT.  The SIT was 
originally developed in conjunction with EPA’s Emissions Inventory Improvement Program 
(EIIP) in order to automate the steps states would need to take in developing their own 
emission estimates in a manner that was consistent with prevailing national and state 
guidelines.   The result was a user-friendly and comprehensive set of eleven modules that 
help users estimate greenhouse gas emissions at the state level.    

Because most state inventories developed today rely heavily on the SIT, User’s Guides have 
been developed for each of the SIT modules.  These User’s Guides contain the most up-to-
date methodologies that are, for the most part, consistent with the Inventory of U.S. 
Greenhouse Gas Emissions and Sinks (EPA 2022a).  Users can refer to the chapters and 
annexes of the U.S. Inventory to obtain additional information not found in the SIT or in the 
companion User’s Guide.  

In 2021, EPA began publishing the results of the Inventory of U.S. Greenhouse Gas 
Emissions and Sinks disaggregated by U.S. state (EPA 2022b) to make consistent state-
level GHG data available for all states for use by states, researchers, and the general public. 
However, EPA recognizes that there will be differences between the state-level estimates 
published by EPA and inventory estimates developed by states using the SIT or other tools.  
Inventories compiled by states may differ for several reasons, and differences do not 
necessarily mean that one set of estimates is more accurate, or "correct."  In some cases, 
the Inventory of U.S. Greenhous Gas Emissions and Sinks may be using different 
methodologies, activity data, and emission factors, or may have access to the latest facility-
level information through the Greenhouse Gas Reporting Program (GHGRP).  In other cases, 
because of state laws and regulations, states may have adopted accounting decisions that 
differ from those adopted by UNFCCC and IPCC to ensure comparability in national reporting 
(e.g., use of different category definitions and emission scopes consistent with state laws 
and regulations).  Users of state GHG data should take care to review and understand 
differences in accounting approaches to ensure that any comparisons of estimates are 
equivalent or an apples-to-apples comparison of estimates. 

The CO2FFC module calculates carbon dioxide (CO2) emissions from the fuel types shown in 
Table 1 by end-use sector.  While the module provides default data for fuel types 
(depending on availability), users are encouraged to use state-specific data, where 
available.  If using outside data sources, or for a more thorough understanding of the tool, 
please refer to the following discussion for data requirements and methodology. 

1.2.1 Data Requirements 

To calculate CO2 emissions from fossil fuel combustion,1 the following data are required: 

• Fossil fuel energy and non-energy consumption by fuel type and sector (non-energy
consumption applies only to the industrial sector);

1 For this discussion, CO2 emissions from fossil fuel combustion include all of the carbon in fuels that is 
either immediately oxidized or oxidized within a short time period (i.e., less than 20 years).  It thus 
includes carbon in the form of gases, like carbon monoxide.  It also includes short-lived products that 
will be burned after use or decompose quickly.  
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• Carbon content coefficients;

• Carbon stored in products; and

• Percentage of carbon oxidized during combustion.

Because the carbon content of fossil fuels varies by fuel type, it is necessary to compile 
consumption data for each type of fuel (the recommended list of fuels is provided in Table 
1). 

Energy consumption statistics should be collected on 
an energy basis—preferably in British thermal units 
(Btu).  Statistics providing energy consumption data 
in other units, such as barrels or tons, may be used, 
but require conversion to Btu by using the heat 
content of the specific fuel.  If the conversion to 
energy units is necessary, the heat contents that 
were used should be documented (default heat 
contents are provided in the CO2FFC module).  
Please note that even data given in Btu may be 
preceded by a prefix indicating order of magnitude 
(i.e. thousand, million, billion).  For a better 
understanding of the quantity prefixes used with Btu, 
refer to Box 1.  

Box 2: Caution When Using Non-Default Fuel Consumption Data 

If you decide to use fuel consumption data that is different from the default, please be aware of 
the following possible data problems: 
In some cases (e.g., the default EIA’s State Energy Consumption, Price, and Expenditure 
Estimates (EIA/SEDS) data) fuel consumption statistics can include data that is at odds with the 
methodology used in the CO2FFC module.  For example, SEDS motor gasoline consumption 
includes ethanol that is blended into gasoline.  Ethanol is not a fossil fuel, and thus the default 
data in the CO2FFC module has been adjusted to remove the portion of blended gasoline known 
to be ethanol.  If you use external data sources, be sure to determine whether ethanol or other 
biofuels (e.g., biodiesel) are included in total consumption for any particular fuel type.  If so, 
you must subtract the biofuel portion before entering the data into the CO2FFC module.  State 
ethanol data can be obtained from the Federal Highway Administration’s annual Highway 
Statistics report (FHWA 2021) and are taken into account with default data provided in the 
CO2FFC module. 
Users should also be aware of double counting.  For example, EIA’s SEDS data for industrial coal 
consumption includes coal used to make synthetic natural gas, which is accounted for in both 
industrial coal and natural gas consumption data.  This double-counting issue has been 
corrected for in the default dataset contained in the CO2FFC module; similar adjustments may 
need to be made to outside data sources.  State-specific natural gas data can be obtained from 
Table 12 of EIA’s Historical Natural Gas Annual EIA (EIA 2001) and Table 8 of EIA’s Natural Gas 
Annual EIA (EIA 2021) (and is also provided in the CO2FFC module).  

Box 1: Energy Units 
A British thermal unit (Btu) is the quantity 
of heat required to raise the temperature of 
one pound of water one degree Fahrenheit 
at or near 39.2o Fahrenheit. 

Btu British thermal unit 1 Btu 
MBtu Thousand Btu 1x103 Btu 
MMBtu Million Btu 1x106 Btu 
BBtu Billion Btu 1x109 Btu 
TBtu Trillion Btu 1x1012 Btu 
QBtu Quadrillion Btu 1x1015 Btu 
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Table 1. Fuel Types Consumed by Sector 

Residential Commercial Industrial Transportation 
Electric 
Utilities 

International 
Bunker Fuels 

Coal Coal Coking Coal 
Other Coal 

Coal Coal  

Natural Gas Natural Gas Natural Gas Natural Gas Natural Gas  
Petroleum: 
Distillate Fuel 
Kerosene 
Hydrocarbon 

Gas 
Liquids 

 

Petroleum: 
Distillate Fuel 
Kerosene 
Hydrocarbon 

Gas 
Liquids 

Motor 
Gasoline 

Residual Fuel 
 

Petroleum: 
  Distillate Fuel 
  Kerosene 
  LPG 
  Motor Gasoline 
  Residual Fuel 
  Lubricants 
  Asphalt/Road 

Oil 
  Crude Oil   
  Feedstocks 
  Misc. 

Petroleum 
Products 

  Petroleum 
Coke 

  Pentanes Plus 
  Still Gas 
  Special 

Naphthas 
  Unfinished Oils 
  Waxes 
  Aviation 

Gasoline 
Blending 
Components 

  Motor Gasoline 
Blending 
Components 

Petroleum: 
  Distillate Fuel 
  Hydrocarbon 

Gas Liquids 
  Motor Gasoline 
  Residual Fuel 
  Lubricants 
  Aviation 

Gasoline 
  Jet Fuel, 

Kerosene 
  Jet Fuel, 

Naphtha 

Petroleum: 
  Distillate 

Fuel 
  Residual 

Fuel 
  Petroleum 

Coke 
 

Petroleum: 
Jet Fuel, 

Kerosene 
Distillate Fuel 
Residual Fuel 

Other (e.g. 
geothermal) 

Other (e.g. 
geothermal) 

Other (e.g. 
geothermal) 

Other (e.g. 
geothermal) 

Other (e.g. 
geothermal) 

 

  Source: U.S. EPA 2022a. 
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1.2.2 Tool Layout 

Because there are multiple steps to complete within the CO2FFC module, it is important to 
have an understanding of the module’s overall design.  The layout of the CO2FFC module 
and the purpose of its worksheets are presented in Figure 3.  

Figure 3. Flow of Information in the CO2FFC Module* 

* These worksheets are the primary worksheets used in the CO2FFC module; subsequent worksheets are used to
populate the default data and are provided for informational purposes only.

1.3 METHODOLOGY 

This section provides a guide to using the CO2FFC module of the SIT to estimate CO2 
emissions from sectors that consume fossil fuels.  Within the CO2FFC module, these sectors 
are residential, commercial, industrial, transportation, electric power, and bunker fuels.  
Because the methodology is similar in 
all sectors, a general methodology is 
discussed and specific examples for 
each sector are provided. 

The CO2FFC module automatically 
calculates emissions after you enter 
energy consumption data (and the 
factors on the control worksheet).  The tool provides default energy consumption data, 
which comes from the EIA’s State Energy Consumption, Price, and Expenditure Estimates 
(SEDS) EIA (2022).2  However, other state-specific data may be used if available (see Box 
3 for suggestions on where to find data).   

The CO2FFC module follows the general methodology from the National Inventory Report 
(NIR) GHG Inventory by U.S. State. However, SIT includes emissions from the non-energy 
use of fossil fuels within the total emission estimates produced by the CO2FCC module, while 
the NIR reports these separately. SIT also provides an alternative approach to estimating 

2 These data are available at https://www.eia.gov/state/seds/. 

Box 3: State Energy Data Sources 
In-state sources, such as state energy commissions or public 
utility commissions, should be consulted first.  Otherwise, 
default data provided by the CO2FFC module may be used.  
Fossil fuel statistics should be provided on an energy basis 
(e.g., in Btu).  

 

 

https://www.eia.gov/state/seds/
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CO2 emissions from transportation utilizing vehicle miles traveled (VMT); this approach is 
calculated in the Mobile Module. SIT also includes an optional module to estimate emissions 
associated with electricity consumption.  

This User’s Guide provides an overview of the estimation methodology used in the CO2FFC 
module by walking through the following eleven steps: (1) select a state; (2) fill in the 
variables used throughout the module; (3) complete the bulk data energy consumption 
worksheet; (4) complete the residential sector worksheet; (5) complete the commercial 
sector worksheet; (6) complete the transportation sector worksheet; (7) complete the 
electric power sector worksheet; (8) complete the bunker fuels sector worksheet; (9) 
complete the industrial sector worksheet; (10) review summary information; and (11) 
export data.   

The general equation used to calculate CO2 emissions from fossil fuel combustion is shown 
in Equation 1.  The equation used for fuels in the industrial end-use sector is similar, but 
includes the non-energy use of fuels, as shown in Equation 2. 

Equation 1.  General Emission Equation 
Emissions (MMTCO2E) = 

Consumption (BBtu) × Emission Factor (lbs C/BBtu) × 0.0005 short ton/lbs × Combustion 
Efficiency (% as a decimal) × 0.9072 (Ratio of Short Tons to Metric Tons) ÷ 1,000,000 ×  

(44/12) (to yield MMTCO2E) 

Equation 2.  Emission Equation for the Industrial Sector* 
Emissions (MMTCO2E) = 

(Total Consumption (BBtu) – [Non-Energy Consumption (Bbtu) × Storage Factor (%)])  
× Emission Factor (lbs C/BBtu) × Combustion Efficiency (% as a decimal) 

× 0.9072 (Ratio of Short Tons to Metric Tons) ÷ 1,000,000 × (44/12) (to yield MMTCO2E) 

* This equation also applies to lubricants consumed in the transportation end-use sector.

Box 4: Treatment of Biofuels in the SIT 
The CO2 from Fossil Fuel Combustion (CO2FFC) module relies on EIA's SEDS database for state-
level energy consumption data. The SEDS data provides consumption estimates at the state 
level for ethanol blended into gasoline. Ethanol is not a fossil fuel, and thus the default data in 
the CO2FFC module has been adjusted to remove the portion of blended gasoline known to be 
ethanol. 

Ideally, biodiesel blended into diesel fuel and other biofuels blended into heating fuels, etc. 
should be treated in the same way to avoid counting emissions from non-fossil fuels. However, 
due to the lack of state-level data on biofuel consumption, it is not feasible to adjust the default 
consumption data in the CO2FFC module to account for these biofuels at this time. The user 
should note that this may lead to some overestimation of emissions from fuel consumption by 
not considering all blended biofuels. EPA is continuously monitoring data availability and 
methodologies that will allow for biofuel adjustments in future versions of the CO2FFC module.  

Users are encouraged to adjust the default data and/or enter their own data for diesel and 
heating oil consumption if available, especially if the user has access to biodiesel and/or biofuel 
consumption within their state. Users should refer to the CO2FFC User's Guide for more 
guidance on entering non-default fuel consumption data. 

Users are also encouraged to refer to EIA's documentation for SEDS energy consumption data 
for more information regarding the fuels included in the CO2FFC module. 
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Step (1) Select a State 

To begin, select the state you are interested in evaluating.  By selecting a state, the rest of 
the tool will automatically reset to reflect the appropriate state default data and 
assumptions for use in subsequent steps of the tool.  

Step (2) Fill in the Variables Used Throughout the Module  

Step 2 requires users to select appropriate factors for several key variables necessary for 
estimating CO2 emissions from fossil fuel combustion.  This can be done by selecting the 
default data provided or entering user-specified, fuel-specific data for combustion 
efficiencies, carbon contents, and non-energy use storage factors that will be used 
throughout the tool.  To select the default data, select the “Clear/Select All Defaults” button 
for each group of variables (combustion efficiency, carbon content, and non-energy use 
storage factors) or check the default box directly to the right of individual yellow input cells.  
Note that users may select a default value and later override it if better data becomes 
available.  To enter state-specific data from other sources, enter values directly into the 
yellow input cells.  If the user-specific inputs do not match the default data in the control 
worksheet (i.e., the default value is overwritten), the text will appear red. See Figure 4 for 
locations of the “Clear/Select All Defaults” buttons, individual default check boxes, and 
yellow input cells.  Information for combustion efficiencies, carbon contents, and non-
energy use storage factors are discussed individually below. 

Figure 4. Control Worksheet for the CO2FFC Module 

 

Required Data 

Select All Defaults 

Individual Default 
Data Check Boxes 
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Combustion Efficiencies 

The first type of required data in the control worksheet is combustion efficiency (percent 
carbon oxidized).  This percent is applied if the carbon is not completely oxidized during the 
combustion of fossil fuels.  The fraction oxidized was assumed to be 100 percent for 
petroleum, coal, natural gas, and LPG based on guidance from IPCC (2006).  If values other 
than module defaults are available for state-level combustion, they should be used and 
documented. Combustion efficiencies are used throughout the module and are pulled into 
each sector’s worksheet.  Figure 5 presents an example of the combustion efficiency used in 
the commercial sector worksheet. If the user-specific inputs do not match the default data 
in the control worksheet (i.e., the default value is overwritten), the text will appear red.  

Figure 5. Example of Combustion Efficiency Data Applied in the Commercial 
Worksheet 

Carbon Contents 

The second type of data required for the control worksheet is the carbon content data, 
which is also pulled into the individual sector worksheets (depending on whether the fuel 
type is represented in the sector).  The carbon content coefficients used in the CO2FFC 
module are from the EPA’s Inventory of GHG Emissions (EPA 2022a).  States are 
encouraged to use more detailed data if it is available and well documented. If the user-
specific inputs do not match the default data in the control worksheet (i.e., the default value 
is overwritten), the text will appear red. 

Carbon content represents the maximum amount of carbon emitted per unit of energy 
released, assuming 100 percent combustion efficiency.  Coal has the highest carbon content 
of the major fuel types, petroleum has roughly 79 percent of carbon per energy as 

Combustion Efficiency 
Data 
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compared to coal, and natural gas has about 57 percent.  However, carbon contents also 
vary within the major fuel types, as noted below: 

• Carbon emissions per ton of coal vary considerably depending on the coal's composition 
of carbon, hydrogen, sulfur, ash, oxygen, and nitrogen.  While variability of carbon 
emissions on a mass basis can be considerable, carbon emissions per unit of energy 
(e.g., per Btu) vary less. 

• The carbon/energy ratio of different petroleum fractions generally correlates with API 
(American Petroleum Institute) gravity (Marland and Rotty 1984).3  Lighter fractions 
(e.g., gasoline) usually have less carbon per unit energy than heavier fractions (e.g., 
residual fuel oil).  

• Natural gas is a mixture of several gases, and the carbon content depends on the 
relative proportions of methane, ethane, propane, other hydrocarbons, CO2, and other 
gases, which vary from one gas production site to another. 

Non-Energy Use Storage Factors 

The third and final type of data requested in the control worksheet is the percent of carbon 
in each fuel that is stored from non-energy uses.  Many fossil fuels have potential non-
energy uses.  For example, LPG is used for production of solvents and synthetic rubber; oil 
is used to produce asphalt, naphthas, and lubricants; and coal is used to produce coke, 
yielding crude light oil and crude tar as by-products that are used in the chemical industry. 

However, not all non-energy uses of fossil fuels result in carbon storage.  For example, the 
carbon from natural gas used in ammonia production is oxidized quickly; many products 
from the chemical and refining industries are burned or decompose within a few years; and 
the carbon in coke is oxidized when the coke is used.  The CO2FFC module provides national 
default values for storage factors, but state-level fractions may differ depending on the type 
of non-energy uses.  Where state-specific estimates are available, their use is preferred, if 
adequate supporting documentation is available. If the user-specific inputs do not match the 
default data in the control worksheet (i.e., the default value is overwritten), the text will 
appear red. Data on the non-energy use storage factor is used in the industrial sector 
worksheet (Step 9).   

Step (3) Complete the Bulk Energy Consumption Data Worksheet 

The energy consumption data entered in the “Bulk Energy Consumption Data” (bulk data) 
worksheet feed into the calculation worksheets for each sector. Modifying the consumption 
data in this worksheet will change the consumption estimates on each sector calculation 
sheet. The default data will automatically be populated in the yellow cells by sector and fuel 
type for the selected state. On the bulk data worksheet, presented as an example in Figure 
6, the yellow cells indicate where the required energy activity data are entered either 
manually or automatically from default data.  Default data in the yellow cells on this 
worksheet can be overwritten with state-specific data. To revert to default data for all 
sectors and fuel types, click on the "Refresh Default Data" button at the top of the 

 

3 Variations in petroleum are most often expressed in terms of specific gravity at 15 degrees Celsius. 
The API gravity, where API gravity = 141.5/specific gravity - 131.5, is an indication of the molecular 
size, carbon/hydrogen ratio, and hence carbon content of a crude oil. 
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worksheet. Click on the "Proceed to Calculation Worksheet" to begin/continue estimating 
emissions, or click on the “Return to Control” button to return to the control worksheet. 

Figure 6. Example of the Required Energy Consumption Data in the Bulk Data 
Worksheet 

 

Step (4) through Step (7) View Emission Estimates on Individual Sector 
Worksheets (Excluding International Bunker Fuels and Industrial Sector) 

With the exception of the industrial sector, the worksheets for each sector have the same 
basic set-up.  On the residential sector worksheet, presented as an example in Figure 7, the 
cells in the first column indicate where the required energy activity data were entered from 
the bulk data worksheet.  These activity data are converted into CO2 emissions using the 
factors entered on the control worksheet, the energy consumption data entered on the bulk 
data worksheet, and the formula presented in Equation 1. Click on the orange "Click here 
for the bulk data worksheet." button to return to the energy consumption data entry 
worksheet. 

The activity data used to populate the energy consumption input cells is annual fuel 
consumption based on primary fuel type (e.g., coal, petroleum, and natural gas) and 
secondary fuel type (e.g., gasoline, residual oil, natural gas, etc.) by sector (e.g., 
residential, commercial, industrial, transportation, and electric utilities).  A list of potential 
fuel types consumed in each sector is provided in Table 1 and is included in the CO2FFC 
module.   

The CO2FFC module calculates emissions for each sector by multiplying consumption by the 
carbon content and the combustion efficiency to obtain the total carbon oxidized.  Then, the 
total tons of carbon oxidized are converted into MMTCO2E, by multiplying by the ratio of 

Required Energy Data 

Refresh Default Data Proceed to Calculation 
Worksheets 

Return to Control 
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metric tons per short ton (0.9072) to obtain metric tons and dividing by 106 and multiplying 
by 44/12 to express emissions in MMTCO2E (Equation 1). 

Figure 7. Example of the Required Energy Data Applied in the Residential 
Worksheet 

Step (8) View Estimates on Bunker Fuels Worksheet 

Emissions from international bunker fuels are calculated in step 7.  International bunker 
fuels are fuels used in marine and aviation transport originating in the United States with 
international destinations.  According to the Revised 1996 IPCC Guidelines, emissions from 
international transport should be reported separately as a memo item, instead of allocating 
them to a particular country.  

Step (9) Complete Non-Energy Use Activity Data on the Industrial Sector 
Worksheet 

The industrial worksheet is unique because both total energy consumption and total non-
energy consumption are required as inputs to calculate CO2 emissions, shown in Figure 8 
(input cells are shown in green).  Including activity data on non-energy use allows 
calculation of the amount of carbon from these fuels that is stored in non-energy products 
for a significant period of time (i.e., more than 20 years).  The CO2FFC module estimates 
carbon stored in non-energy uses for each state by multiplying the total number of Btu 
consumed by the default percent of that fuel type that is used for non-energy purposes, and 
then by a storage factor (i.e., the amount of carbon in non-energy uses that typically 
remains stored for longer than 20 years, entered in Step 2).  This non-energy consumption 
is then subtracted from the total consumption to yield the net combustible consumption.  
From this point forward, the industrial worksheet functions in the same manner as the other 
sector worksheets.  The net combustible consumption is multiplied by the carbon content 

Required Energy Data 

Carbon Content Data 
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and the combustion efficiency to obtain the total carbon oxidized.  Then, the total tons of 
carbon oxidized are converted into MMTCO2E, by multiplying by the ratio of metric tons per 
short ton (0.9072) to obtain metric tons and dividing by 106 and multiplying by 44/12 to 
express emissions in MMTCO2E (Equation 2). Click on the orange "Click here for the bulk 
data worksheet." button to return to the energy consumption data entry worksheet. 

Figure 8. Example of Energy and Non-Energy Consumption Data Applied in the 
Industrial Worksheet 

 

Step (10) Review Summary Information 

The steps above provide estimates of total carbon in fossil fuels consumed, carbon stored in 
non-energy products, and amount of carbon oxidized to CO2.  Total carbon emissions are 
equal to the total carbon content in fuel, minus carbon stored in non-energy uses, adjusted 
for the carbon not oxidized during combustion, and summed over all fuel types and sectors, 
for each year.  The information is collected on the summary worksheet, displaying results in 
MMTCO2E.  Figure 9 shows the summary worksheet that sums the emissions from all 
sectors in the CO2FFC module.  In addition, the results are displayed in graphical format at 
the bottom of the summary worksheets.  

Required Non-Energy 
Consumption Data 
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Figure 9. Example of the Emissions Summary Worksheet in the CO2FFC Module 

Step (11) Export Data 

The final step is to export the summary data.  Exporting data allows the estimates from 
each module to be combined later by the Synthesis Module to produce a comprehensive 
greenhouse gas inventory for the state. 

To access the “Export Data” button, return 
to the control sheet and scroll down to the 
bottom (11).  Click on the “Export Data” 
button and a message box will open that 
reminds the user to make sure all steps of 
the module have been completed.  If you 
make any changes to the CO2FFC module 
later, you will then need to re-export the 
results. 

Clicking “OK” prompts you to save the file.  
The file is already named, so you only need to choose a convenient place to save the file.  
After the file is saved, a message box will appear indicating that the data was successfully 
exported.   

Note: the resulting export file should not be 
modified.  The export file contains a summary 
worksheet where users can view the results, as well as a 
separate data worksheet with an unformatted version of 
the results; this data worksheet contains the information 
that is exported to the Synthesis Tool, and it is especially 
important that users do not modify it.  Adding/removing 
rows, moving data, or making other modifications 
jeopardize the ability of the Synthesis Module to 
accurately analyze the data.   
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While completing the modules, you are encouraged to save each completed module; doing 
so will enable you to easily make changes without re-running it entirely. 

Following data export, the module may be reset and run for an additional state.  
Alternatively, you may run the remaining modules of the State Inventory Tool to obtain a 
comprehensive profile of emissions for your state.  

 

1.4 UNCERTAINTY 

In the upper right-hand corner of the summary worksheet is a button: “Review discussion of 
uncertainty associated with these results.”  By clicking on this button, you are taken to a 
worksheet that discusses the uncertainty surrounding the activity data and emission factors, 
and how the uncertainty estimates for this source category affect the uncertainty of the 
emission estimates for your state. 
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